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Introduccion

iBienvenidos a Rebelle!

Rebelle es una aplicacion de pintura Unica que le permite crear obras de arte realistas de las
medios hiumedos y secos, con simulacion impresionante y dinamica de flujo de fluidos, de la
mezcla de color, difusion humeda y del secado.

Hemos disefiado Rebelle para los artistas CG, asi como para los pintores tradicionales que
quieren explorar y ampliar su repertorio artistico, utilizando la ultima tecnologia digital
innovadora de la pintura.

En este manual encontrard informacién general sobre todos los detalles que necesita saber
para un uso de este software. Hemos preparado las explicaciones de sus caracteristicas,
indicios utiles y antecedentes técnicos de Rebelle para ustedes.

iGracias por comprar Rebelle, espero que pase gran tiempo con la pintura!

Peter Blaskovic
Creador de Rebelle
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Empezamos

Instalar y Registrar Rebelle

Descargar & Instalar

Después de comprar Rebelle desde nuestro sitio web, recibird el correo electrénico con un
enlace para descargar y con detalles para registrar.

Usuarios de Mac OS X
Descarga un archivo .dmg del enlace que aparece en un correo electrénico. Localice el

archivo de instalacion de Rebelle llamado "Rebelle.dmg". Haga doble clic en el archivo de
instalacidn para completar la instalacion.

Usuarios de Windows

Descarga un archivo .exe para el sistema 32 o 64-bit del enlace que aparece en un correo
electrdnico. Localice el archivo de instalacion de Rebelle llamado "Rebelle.exe". Haga doble
clic en el archivo de instalacion .exe para completar la instalacion.

Registrar

Introduzca sus datos para registrar desde el correo electrdnico. Por favor, compruebe si estd
conectado a Internet, se requiere la conexién a Internet para la activacién para comprobar
los datos de registro.

SUGERENCIA: Le recomendamos copiar & pegar su Clave de Registro e ID para evitar la falta
de ortografia.

Iniciar la Aplicacion

Vera un “Intro Tutorial” durante el primer inicio de la aplicacién, o después de cada
actualizacidn a la versidon mas reciente. Este tutorial le guiard a través de las herramientas
mas esenciales de Rebelle. Puede abrir este “Intro Tutorial” desde Menu -> Ayuda (Menu ->
Help) en cualquier momento.



Requisitos del Sistema

Minimos: Intel i3 o equivalente AMD procesador, 4GB de RAM, espacio de disco duro de
100MB, tarjeta grafica Open GL con 1GB RAM, Windows XP, Vista, o OS X 10.7 — en esta
configuracion la simulacién de acuarela puede funcionar mas lento, procesador mas rapido y
mas memoria son preferibles.

Recomendados: Intel i7 o equivalente AMD procesador, 16GB de RAM, espacio de disco
duro de 100MB, tarjeta grafica Open GL con 2GB RAM, Windows 7, 8 0 OS X 10.8, 10.9,
10.10, 10.11, 10.12, tableta grafica Wacom.

Obtener Soporte para Rebelle

Si necesita ayuda para utilizar Rebelle, en primer lugar consulte el manual incluido. Hemos
intentado hacerlo facil para leer y lleno de informacion que necesita saber.

Le invitamos a enviarnos un correo electrdonico a support@escapemotions.com si usted tiene
cualquier pregunta, problema técnico con Rebelle, o le gustaria simplemente para
saludarnos.

Antes de hacer preguntas por favor lea la FAQ en ‘support’ seccion en el sitio web
rebelle.escapemotions.com en primer lugar. Si la respuesta no estd ahi, por favor agrega la
configuracion de su equipo a su correo electronico (Windows / Mac OS, 32 / 64 bits del
sistema operativo, procesador, tarjeta grafica, memoria). Esto nos ayudard a proporcionar
respuestas mucho mas rapido.

Comunidad
Sigamos en contacto en nuestros canales sociales - haga clic en cualquier icono y visitar

nuestras paginas en Facebook, Twitter, Pinterest, Google+, Tumblr, YouTube, DeviantArt y
Behance.
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support@escapemotions.com
https://www.facebook.com/flamepainterpage?ref=hl
https://twitter.com/escapemotions
http://www.pinterest.com/escapemotions/
https://plus.google.com/u/1/b/109066869359827919028/109066869359827919028/posts
file:///C:/Users/Ada/Dropbox/Escape Motions/!_Rebelle/Manual/tumblr.com/blog/escapemotions
https://www.youtube.com/user/EscapeMotions
http://escmot.deviantart.com/
https://www.behance.net/escapemotions

Interfaz de Rebelle
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1 — Barra de Menu (Menu Bar)

2 — Panel de Navegador (Navigator Panel)

3 — Panel de Herramientas (Tools Panel)

4 — Panel de Propiedades (Properties Panel)

5 — Panel de Color (Color Panel)

6 — Panel de Conjunto de Colores (Color Set Panel)
7 — Panel de Capas (Layers Panel)

8 — Panel de Inclinacidn (Tilt Panel)

9 — Lienzo (Canvas)

SUGERENCIA: Paneles de Navegador, Herramientas, Propiedades, Color, Conjunto de Colores,
Inclinacion y de Capas son acoplables - es posible modificar, cambiar de posicion y ajustar la
anchura de los paneles. Los paneles ocultan mientras que se pinta en el lienzo detrds de ellos.



Puede cambiar la interfaz de Rebelle de acuerdo a sus necesidades. Abajo estan los ejemplos

de diseno de interfaz de usuario:

1. Interfaz predeterminada con el 2. Panel de Herramientas y Propiedades en
Panel de Inclinacién no acoplado. modo vertical en el lado izquierdo, los otros
paneles son fusionados en el lado derecho.

4. Paneles de Herramientas, Propiedades y
Conjunto de Colores en modo vertical son
fusionados en el lado izquierdo con el Panel de
Color no acoplado.

3. Paneles de Herramientas y Propiedades en
modo horizontal en la parte superior, los otros
paneles son fusionados en el lado izquierdo.



Panel de Herramientas

- Pinceles: Acuarela, Acrilico, Pastel, Lapiz, Pluma,
Rotulador y Aerégrafo.

- Borrador

- Herramientas: Fusionar, Manchar, Mojar, Secar,
Soplar, Escoger Color y Transformar.

- Deshacer / Rehacer

~ Contraer Panel - Contraiga el Panel de Herramientas. Este botdn estd presente en todos
los paneles de la interfaz de Rebelle.

— Menu de Panel de Herramientas: Seleccione para cerrar el panel. Es posible mostrar el
panel de nuevo desde el Menu de Ventana (Window menu).

La siguiente imagen muestra el comportamiento de cada técnica de pintura:

Watercolor Acrylic Pastel

Pencil Ink Pen Marker Airbrush

\

f Fusionar - Herramienta para fusionar los colores o marcas de pincel.
» Manchar - Herramienta para manchar los colores o marcas de pincel.

O Mojar - Seleccione la herramienta de mojar para afiadir agua a una parte especifica del
lienzo.



Secar - Seleccione la herramienta de secar para eliminar agua de una parte especifica del
lienzo.

= Soplar - Seleccione la herramienta para soplar los colores humedos.
d
7 Escoger Color - Seleccione la herramienta para escoger el color del lienzo.

X Transformar - Mueve, escale, rote o voltee la capa seleccionada.

D Deshacer - Deshace la Gltima operacion de pintura que ha realizada.

C Rehacer - Rehace la tltima operacion de deshacer.

Propiedades de Herramienta Acuarela

Size 0 Los parametros son predeterminados para simular el
Pressure comportamiento de los acuarelas. Para efectos
Loading 100 diferentes, los parametros se pueden ajustar de
Water acuerdo a sus necesidades:

Tamaiio - Ajuste el tamafio del pincel (1-100).

Presidn - Ajuste la presidn del pincel (1-100). Si se utiliza
la presidn del lapiz de la tableta grafica, puede ajustar la
sensibilidad a la presion.

Cargando - Ajuste la cantidad de color cargado al pincel
(1-100). - Influya el espesor del pincel.

Agua - Ajuste la cantidad de agua (1-100). Cuanta mas

agua estd aplicada en el pincel, mas realista est3 el
efecto de la acuarela que se puede conseguir.

SUGERENCIA: Ajuste "Agua" a 1 para humedecer la capa ligeramente, o ajuste "Agua” a
valores superiores para poner mds agua a la parte especifica del lienzo. No es necesario
utilizar mucha agua para obtener efectos bonitos de acuarela.

s Pincel Permanente (Permanent Brush) - Cuando esta activado, el pincel mantiene su
color todo el tiempo. Con el control deslizante "Cargando" se puede establecer la cantidad
de color que desea cargar al pincel.

9’ Pincel Normal (Normal Brush) - El modo normal del pincel. La cantidad de pigmento
cargado al pincel depende del control deslizante "Cargando".

B’ Pincel Sucio (Dirty Brush) - El pincel sucio nunca se va a limpiar a si mismo y permanece
coloreado por el ultimo color cargado en la misma.
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O Pincel Limpio (Clean Brush) - El pincel limpio no estd cargado con cualquier pigmento en
si mismo. Cuando esta activado, el pincel se re-colorea por cualquier color que pasa a través
del lienzo.

= Mend de Panel de Propiedades - Restablezca a los valos predeterminados o cierre el
panel. Es posible mostrar el panel de nuevo desde el Menu de Ventana (Window Menu).

Propiedades de Herramienta Acrilico

Color de acrilico es el medio humedo utilizado en su
mayoria con pinceles planos. Puede ajustar los
parametros de color de acuerdo a sus necesidades:

Tamaiio - Ajuste el tamanio del pincel (1-100).

Presidn - Ajuste la presién del pincel (1-100) — Influya el
espesor del pincel.

Cargando - Ajuste la cantidad de color cargado al pincel
(1-100).

Agua - Ajuste la cantidad de agua en color (1-100).

SUGERENCIA: Ajuste "Presion"y "Cargando" al valor mds bajo y obtendra un pincel fino.
Establezca los valores mds altos y obtendrd el pincel espeso con una gran cantidad de masa.

& . . . . .
# Pincel Permanente (Permanent Brush) - Cuando esta activado, el pincel mantiene su
color todo el tiempo. Con el control deslizante "Cargando" se puede establecer la cantidad
de color que desea cargar al pincel:

Cargando al ‘1’ Cargando al ‘25’ Cargando al '50’ Cargando al ‘100’
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&
£ Pincel Normal (Normal Brush) - El modo normal del pincel. La cantidad de pigmento
cargado al pincel depende del control deslizante "Cargando":

Cargando al ‘1’ Cargando al 25’ Cargando al '50’ Cargando al ‘100’

£ Pincel Sucio (Dirty Brush) - El pincel sucio nunca se va a limpiar a si mismo y permanece
coloreado por el ultimo color cargado en la misma:

1. trazo: el pincel pasa de color naranja a azul.
2. trazo: el pincel queda coloreado por el Ultimo color
cargado en la misma (en nuestro caso es color azul).

O Pincel Limpio (Clean Brush) - El pincel limpio no estd cargado con cualquier pigmento en
si mismo. Cuando esta activado, el pincel se re-colorea por cualquier color que pasa a través
del lienzo:

1. trazo: el pincel pasa de color naranja a azul. Cuando se
suelta, el pincel se limpia.

2. trazo: el pincel limpia pinta de nuevo desde el naranja al
color azul.

SUGERENCIA: Se puede ajustar los atajos del teclado personalisados para Pincel Permanente,
Normal, Sucio y Limpio en panel de Preferencias. Cuando se ajustan atajos en seccion
Herramientas (Tools), el atajo activard el pincel particular. Cuando se ajustan los atajos en
seccion Herramientas - mantener (Tools - hold) el pincel se activard sélo cuando el atajo estd
mantenido.
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Propiedades de Herramienta Pastel

Pastel es un medio seco en la forma de un palo, que
consiste en pigmento en polvo puro y un aglutinante.
Puede ajustar los pardmetros de acuerdo a sus
necesidades:

Tamaiio - Ajuste el tamafio del pastel (1-100).
Presion - Ajuste la presién del pastel (1-100) — Influya el
espesor del pastel.

Propiedades de Herramienta Lapiz

Lapiz de color es un medio artistico construida de un
nucleo estrecho y pigmentada encerrado en una caja
cilindrica de madera. Puede ajustar los parametros de
acuerdo a sus necesidades:

Tamaiio - Ajuste el tamafio del [apiz (1-100).
Presion - Ajuste la presidn del lapiz (1-100) — Influya el
espesor del lapiz.

Propiedades de Herramienta Pluma

La tinta es un liquido que contiene pigmentos o
colorantes. Puede ajustar los parametros de acuerdo a
sus necesidades:

Tamaiio - Ajuste el tamaiio de la pluma (1-100).
Presion - Ajuste el espesor de la pluma (1-100).
Agua - Ajuste la cantidad de agua en color (1-100).
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Propiedades de Herramienta Rotulador

Rotulador es una pluma que tiene su propia fuente de
tinta y generalmente una punta hecha de fibras porosas y
presionadas tales como fieltro. Puede ajustar los
parametros de acuerdo a sus necesidades:

Tamaiio - Ajuste el tamafio del rotulador (1-100).
Presion - Ajuste el espesor del rotulador (1-100).

Propiedades de Herramienta Aerdégrafo

Aerdgrafo es una herramienta pequeia, operada por aire
que rocia diversos medios incluyendo la tinta y el tinte.
Puede ajustar los parametros de acuerdo a sus
necesidades:

Tamaiio - Ajuste el tamafio del aerégrafo (1-100).
Presion - Ajuste la presién del aerdégrafo (1-100) —
Influya la densidad del aerdgrafo.

Propiedades de Herramienta Borrador

Tamaio - Ajuste el tamario del borrador (1-100).
Presion - Ajuste la presién del borrador (1-100).

Softness

Suavidad - Seleccione la suavidad. Un valor alto hace que

[1 Keep Layer wek

el borrador es mas suave, mientras que un valor bajo
rasca el papel y deja la estructura del papel mas visible.
Mantener Capa Himeda - Active esta opcidn si desea
que el borrador mantiene el drea borrada humeda para
pintura posterior. El borrador seque completamente el
area borrada por defecto.

SUGERENCIA 1: Ajuste “Presion” a los valores bajos y borrador serd ligeramente rayar la
pintura.
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SUGERENCIA 2: Puede ajustar la punta del borrador de un Idpiz de tableta grdfica a borrador

en Rebelle via Preferencias -> Herramientas (mantener) / Preferences -> Tools (hold).

Seleccione Borrador y lo ajuste a Ldpiz (Borrador) en la parte inferior de la ventana.

Ci=
JZe

Pressure

Size

Pressure

[1 smudge All

Propiedades de Herramienta Fusionar
Esta herramienta fusione los colores y pinceladas.

Tamaiio — Ajuste el tamafio de la herramienta Fusionar
(1-100).

Presion - Ajuste la presion de la herramienta Fusionar
(1-100).

SUGERENCIA: Puede fusionar colores con el toque de un
dedo en las tabletas con pantallas tdctiles. Puede
cambiar esto en cualquier momento en el panel de
Preferencias.

Propiedades de Herramienta Manchar
Esta herramienta mancha las partes himedas y secas de
la pintura.

Tamaiio - Ajuste el tamafiio de la herramienta Manchar
(1-100).

Presidn - Ajuste la presidn de la herramienta Manchar
(1-100).

Manchar Todo - Active esta opcion si desea manchar la
pintura hiumeda y seca. Cuando se desactiva,
herramientas mancha sélo partes hiumedas de Ia
pintura:

Manchar - sélo humeda Manchar Todo - humeda y seca

En cada uno de los Paneles de Herramientas se puede elegir diversas estructuras del pincel.
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Nota: Las texturas del pincel son accesibles a través del menu: Ayuda -> Mostrar Carpeta de
Bibliografia (Help -> Show Library folder), donde se puede pegar cualquier pincel a la carpeta
"Brushes" (imagen del pincel debe ser de 512x512 pixeles y en formato PNG).

Propiedades de Herramienta Mojar

Tamaiio - Ajuste el tamafio de la herramienta Mojar (1-
100).

Agua - Seleccione una cantidad de agua.

Cuanta mas agua se selecciona, el mas humedo el lienzo
se pone.

Propiedades de Herramienda Secar

Size

Tamaiio - Ajuste el tamafio de la herramienta Secar (1-
Absorben 100)

L1 Keep Lay Absorbencia - Seleccione un poder de absorcidn del
lienzo. Cuanto mayor es el nimero seleccionado, el mas

rapido la agua se absorbe.

Mantener Capa Himeda - Active esta opcidn si desea
qgue la herramienta Secar mantiene el drea secada
himeda para pintura posterior. La herramienta Secar

seque completamente el drea por defecto.

Nota: Las Herramientas Mojar y Secar automdticamente activan modo de ‘Mostrar Himedo’.
Puede cambiarlo a través Menu: Archivo -> Preferencias -> Herramientas (File -> Preferences
-> Tools) donde desactive la opcion ‘Mostrar capa humeda cuando se ulitiza la herramienta
Mojar o Secar’.
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Mix Color:

Sample;

Sample Size;

New color

Color sample

Original color

Propiedades de Herramienta Soplar

Esta herramienta sopla un color que es himedo en la
direccion de su movimiento.

Tamaiio - Ajuste el tamafio de la herramienta Soplar (1-
100).

Propiedades de Herramienta Escoger Color

Esta herramienta le permite escoger color de la capay
del lienzo y mezclarla con otro color.

'_f Mezclar Colores - Presione el botén "Mezclar
Colores" o mantenga la tecla "X" para mezclar el color
escogido con el color anterior.

Muestra:

Capa - El color se escogid sélo de una capa activa.

Todas Capas - El color se escogid de todas las capas
excepto un color del lienzo de fondo.

— Lienzo - El color se escogid de todas las capas que
incluyendo el lienzo de fondo.

Tamaiio de Muestra - El tamano promedio de Ia
muestra.

Cuando la herramienta Escoger Color se selecciona el
cursor cambia a un circulo con tres zonas de colores
diferentes:

Color Original - El color seleccionado.

Muestra de Color (Sample) - El color del lienzo debajo
del disco.

Color Nuevo (New Color) - El color seleccionado nuevo.
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Propiedades de Herramienta Transformar

-
|:';|

Transforme la capa actual y su posicion.

wideh 128 X - Ajuste la posicién X de la capa.

Height 500 Y - Ajuste la posicién Y de la capa.

Angle  0.00° Cuando ambas posiciones se establecen a 0, la capa se
4 A transforma al lado izquierdo y superior del lienzo.

Anchura - Ajuste la anchura de la capa.
Altura - Ajuste la altura de la capa.

Angulo - Ajuste el angulo de la rotacion.

- . .
= Voltear Verticalmente - Voltee la capa verticalmente.

A Voltear Horizontalmente - Voltee la capa horizontalmente.

La siguiente imagen muestra cémo utilizar la Herramienta Transformar con el ratén, stylus
de la tableta y el toque:

Scale
S g 7
% Move 9 Rotate
= 4 = %
\
Use two fingers P J Use mouse, finger or pen
to transform layer. ! to transform layer.

Mover - Mueve una capa transformada.

Escalar - Escale para aumentar o reducir una capa transformada en relacidn a su esquina
superior izquierda. Puede escalar una capa horizontalmente, verticalmente o ambos. Utilice
teclado Shift para escalar proporcionalmente. Utilice teclado Alt para escalar una capa con
respecto a su centro.

Rotar - Herramienta rote una capa transformada alrededor de su centro. Utilice teclado Shift
para bloquear la rotacién en angulos de 45 grados.

Mueve, escape y rote con ratdn, stylus o con el toque. Utilice dos dedos para mover, rotar y
escalar la capa simultaneamente. Mas informacién sobre el soporte tactil en Rebelle se
puede encontrar en la seccién ‘Soporte Multitactil’ (Multi-touch Support).
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Panel de Navegador

Utilice el panel de Navegador para cambiar con rapidez
la vista de la pintura utilizando una visualizacién en
miniatura. El cuadro negro del navegador corresponde
al area visible actualmente en la ventana.

Q Reducir - Reduzca la vista de la pintura (a un
tamaiio minimo de 5%).

Q Aumentar - Aumente la vista de la pintura (a un

tamafio maximo de 2000%).
Control de Zoom - Ajuste el zoom utilizando el control
de zoom (1 - 2000%).

Q Restablecer Zoom - Compruebe el valor de zoom aqui. Pulse el botdn para restablecer el
zoom al 100%.

O Encajar en Pantalla - Encaje el lienzo en la pantalla.

o) Rotar Sinistrorso - Rote la ventana graéfica sinistrorso.

@ Rotar Dextrorso - Rote la ventana grafica dextrorso.
Control de Rotacidn - Ajuste el valor de rotacion con el control de rotacién (-180° - 180°).

® Restablecer Rotacion - Pulse el botdn para restablecer el valor de rotacién al 0°.

Pl4 voltear - Voltee la ventana grafica. Herramienta Voltear en panel de Navegator voltea la
ventana grafica de forma no destructiva y no transforme el imagen. El botdn estd activado
cuando la ventana grafica esta volteada.

= Men de Panel de Navegador - Cambie a Escala de grises o cierre el panel. Es posible
mostrar el panel de nuevo desde el Menu de Ventana (Window Menu).
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Panel de Inclinacion

Herramienta inclinacion afecta el movimiento de pintura himeday
estd representado por un circulo con un puntero, que se puede
mover y rotar. Active / desactive la inclinacion haciendo clic en el
circulo central. Establezca la direccién y el angulo de la inclinacién del
lienzo haciendo clic en el puntero. Cuanto mas larga es la linea de la
inclinacién, el mayor es el dngulo.

Nota: La velocidad de chorreados de color depende de la inclinacion del lienzo, cantidad de

agua y color en la pintura.

— Menu de Panel de Inclinaciéon

- Bloquear Inclinacién al Lienzo - Bloquee la inclinacién
para mantener su direccion cuando rota el lienzo.

- Usar Acelerémetro - Utilice el acelerémetro de la
tableta grafica para influir la inclinacidn del lienzo y flujo
del color mediante la inclinacién de la tableta. Puede
ajustar la sensibilidad del acelerémetro en Preferencias -
> Herramientas (Preferences -> Tools).

- Centrar Acelerémetro - Centre el acelerémetro para
establecer un grado cero.

- Cerrar - Cierre el Panel. Es posible mostrar el panel de
nuevo desde el Menu de Ventana (Window Menu).
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Panel de Color

Elija su color del pincel en Panel de Color.

Color Actual - Ajuste el color actual.

Paleta de Color - Seleccione el color del pincel desde la
paleta de colores o introduzca pardmetros numéricos
exactos para establecer su color requerido.

Puede cambiar entre HSL y RGB modelos de color:
H - Matiz del Pincel (0 - 359)

S - Saturacion del Pincel (0 - 255)

L - Luminancia del Pincel (0 - 255)

o

R - Red / Rojo (0-255)

G - Green / Verde (0-255)

B - Blue / Azul (0-255)

Nota: RGB es un modelo de color dependiente del dispositivo - diferentes dispositivos /
monitores pueden reproducir un valor RGB determinado de manera diferente.

= Men de Panel de Color - Cambie entre la paleta circula y paleta cuadrada, muestre o
oclute controles deslizadores, cambie entre HSL y RGB paleta de color o seleccione cerrar
panel. Es posible mostrar el panel de nuevo desde el Menu de Ventana (Window Menu).

TIP: Puede ajustar atajos de teclado personalizados para aumentar / disminuir el matiz,
saturacion y luminancia desde el panel de Preferencias. También es posible ajustar la
sensibilidad del ajuste.
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Panel de Conjunto de Colores

Puede elejir su color del pincel también en Panel de

Conjunto de Colores.
HER J
EEEEEEEEE

Conjunto de ultimos colores usados - Puede crear sus
colores personalizados escogiendo y haciendo clic en el
color en la paleta de colores. La ultima color utilizada se
ordenara en el primer lugar.

Conjunto de colores - Una paleta del conjunto de
colores seleccionado. Puede agregar colores
personalizados - se guardaran para un proyecto de
pintura adicional aun cuando una aplicacion esta
cerrada.

o Mezclar Colores - Presione el boton "Mix Colors /
vellow @ Mezclar Colores" o mantenga la tecla "X" para mezclar
(=) el color escogido con el color anterior. Se puede mezclar

colores de conjunto de color, de la paleta o del lienzo.
Ejemplo: Si quiere que su color rojo a ser mds naranja en
el tinte, haga clic en la muestra de color naranja o de
pixeles de color naranja sobre lienzo - el espectro se
moverd hacia el tinte rojo-anaranjado. Cuanto mds se
hace clic en el color naranja, el tono mds naranja se
pone.

Z Usar Trazado de Color - Cuando esta seleccionado, el color es recogido
automaticamente de la capa de trazado. Establezca una capa activa como una capa de
trazado de referencia desde el Menu de Panel de Capas o desde Barra de Menu -> Capa ->
Capa de Trazado (un pequeiio T en la vista previa de capa aparecerd). Esta capa es una guia
para las formas y colores a su pintura.

***" Ordenar por Matiz - Ordene colores por su valor de Matiz. Cuando desactivado, el color
ultimo afiadido se ordenara como primero.

/ B - Agrega y elimina colores personalizados desde Conjunto de Colores.

Conjuntos de Colores Personalizados - Cree su propio conjunto de colores. Haga clic en el
botén para agregar el nuevo conjunto, el botén para duplicar el conjunto

seleccionado o B para eliminar conjunto seleccionado.
Puede cambiar el orden de conjuntos con arrastar y soltar o cambiar el nombre del
conjunto seleccionado haciendo doble clic.
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= Menu de Panel de Conjunto de Colores:

- Mostrar nombres de colores - Muestre nombres de colores. Puede cambiar el nombre de
color seleccionado haciendo doble clic.

- Crear conjunto de colores de imagen - Cree un conjunto de colores del imagen
seleccionado.

- Cerrar - Cierre el panel de Conjunto de Colores. Es posible mostrar el panel de nuevo desde
el Menu de Ventana (Window Menu).

Paleta de Colores de Sistema
Después de hacer clic en un color actual en la esquina superior izquierda del Panel de Color,

una nueva ventana de Seleccionar color con una Paleta de Colores del Sistema aparece. Esta
paleta se ve y se comporta de manera diferente en Mac OS y Windows:

;9“0 Colors =

| @[5l

Q) |
-+

Pick Screen Color

Red: 25

Custom colors

Add to Custom Colors

Green: 4

Blue: 121

Cancel -

Paleta de Colores de Sistema en Windows =

4 N\ £

(_ Cancel ) C oK )
A

Paleta de Colores de Sistema en Mac 0S

Para usuarios de Windows:
Puede escoger cualquier color de la pantalla haciendo clic en un botdn de "Pick Screen
Color". Al pasar por encima de su pantalla veras HSV, RGB y HTML pardmetros de un color.

El uso de la opcién 'Custom Colors" en la ventana de Paleta de colores para guardar los

colores no es necesario. Si desea guardar su color personalisado, le recomendamos que
utilice el botén "Agregar / Add" directamente en el Panel de la Paleta.
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Panel de Capas

@ Mostrar Himedo - Muestre las partes humedas de
@ (1) ses 55§ afp la capa actual.

Blending .. E]/@ Pausar Difusion - Pause la difusion. Cuando

estd pausada, el botén estd marcado.

£2% Humedecer Capa - Humedece la capa actual.

58

humedo.

Secar Capa - Seque la capa actual, el lienzo no es

ale Secar Rapido - Seque la capa actual, el agua se
elimina de la pintura, pero el lienzo permanece
hiamedo.

Note: Al cambiar capas, la capa actual se seca rdpida (el
agua se seca, pero el lienzo permanece humedo) y la
capa nueva es seleccionada después.

Fusion - 23 modos de fusion: Normal, Oscurecer, Multiplicar, Subexponer Color,
Subexposicién Lineal, Aclarar, Trama, Sobreexponer Color, Sobreexposicion Lineal,
Superponer, Luz Suave, Luz Fuerte, Luz Intensa, Luz Lineal, Luz Focal, Mezcla Definida,
Diferencia, Exclusidn, Restar, Tono, Saturacion, Reguladores y Luminosidad.

Opacidad - Ajuste la opacidad de la capa. (0-100).

8 Bloquear Capa - Bloquee la capa o capas seleccionadas para protegerlos de cambios no
deseados. Capa de trazado se bloqueara de forma predeterminada.

® Ojo - Muestra u oculta la capa activa.

Letra T en vista previa de Capa - Esta letra indica una capa de trazado. Seleccione una capa
de una Lista de capas, establezca esta capa como capa de trazado de referencia desde
Menu: Capa -> Capa de Trazado (Layer -> Tracing Layer). Esta capa es una guia para las
formas y colores a su pintura - puede ser una imagen o una foto.

Lienzo - Elija entre 10 texturas y 15 colores del lienzo.
Se puede controlar la visibilidad de |a textura del lienzo utilizando el control Visibilidad de
Textura (0-100) en la ventana Seleccionar Lienzo.
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Se puede controlar escalado de la textura del lienzo utilizando el control Escalado de
Textura (50-400%) en la ventana Seleccionar Lienzo.

SUGERENCIA: Haga clic en el ojo ® 4l lado de un icono del lienzo para mostrar u ocultar la
textura del lienzo. Cuando se oculta, se puede guardar la pintura con el fondo transparente.

Puede encontrar mas informacidn acerca de las texturas del papel en la seccién ‘Lienzos
Artisticos’.

E Limpiar Capa - Limpie el contenido de la capa (atajo Del).
Nueva Capa - Agrega una nueva capa.
@ Duplicar Capa - Duplique capa o capas activas.

= Fusionar Capas - Fusione mas capas en una capa. Si una sola capa esta seleccionada, se
fusionara automaticamente con la capa debajo de ella.

B Eliminar Capa - Elimine la capa o mas capas seleccionadas.

TIP: Arrastre la capa seleccionada arriba de cualquiera de estos botones para ejecutar sus
funciones en esa capa.

Se puede cambiar el nombre de una capa activa con un doble clic sobre ella en una Lista de
Capas.
Se puede arrastrar y soltar las capas para acomodarlos en el orden deseado.

= Men de Panel de Capas - Seleccione una Capa de Trazado o cierre el panel. Es posible
mostrar el panel de nuevo desde el Menu de Ventana (Window Menu).
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Barra de Menu

Archivo - Contiene acciones relacionadas con cargar, guardar, exportar y publicar sus
pinturas.

Editar - Contiene articulos relacionados con la edicién del proceso de pintura y el lienzo.
Capa - Contiene acciones relacionadas con las capas.

Vista - Contiene acciones relacionadas con la ventana gréfica.

Ventana - Contiene acciones relacionadas con la interfaz de usuario.

Ayuda - Contiene acciones que permiten obtener ayuda de la aplicacién, o buscar
actualizaciones en la pagina web.

Menu de Archivo

El Menu de Archivo contiene acciones relacionadas con su pintura de la siguiente manera:

Nuevo... - Abre el cuadro de didlogo que le permite crear una nueva pintura con los nuevos
ajustes. Puede establecer la anchura y la altura de la nueva imagen en pixels, centimetros o
inches y una DPI de la imagen; ajuste la textura y color del lienzo, la visibilidad y escalado de
la textura (mas sobre los papeles en la seccidn ‘Lienzos Artisticos’):

Picture Size: Picture Size Info:

Width: 1500 pixels . @ pi 1500 x 800 pixels

, _ 52.92 x 28.22 cm
Height: 800 pixels 20.83 x 11.11 inches

Presels:
Canvas:
Quarter Sheet, 15.00 x 11.00 inches, 160 DPI

Half Sheet, 22.00 x 15.00 inches, 120 DPI

Full Sheet, 30.00 x 22.00 inches, 80 DPI -
Double Elephant, 40.00 x 30.00 inches, 60 DPI
Emperor, 60.00 x 40.00 inches, 40 DPI

A4, 29.70 x 21.00 cm, 200 DPI
A3, 42.00 x 29.70 cm, 150 DPI

AT CO AR w AT AN s 4000 0

C]

Cancel

También puede elegir entre variedad de ajustes de tamafio del lienzo o agregar / eliminar

ajustes preestablecidos usando los botones @ / @
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Después de hacer clic en un icono de Lienzo, una nueva ventana aparece con una eleccion de
lienzos artisticos preestablecidos.

Segun DPI valor que se establece, informacidn sobre el tamafio del imagen se calcula
automadticamente tanto en centimetros y pulgadas.

Nota: Tenga en cuenta que el establecimiento de las resoluciones mds grandes para su
imagen puede retrasar su ordenador; especialmente si se utiliza una gran cantidad de agua
en la pintura.

Abrir... - Abre el cuadro de didlogo que le permite cargar una imagen desde disco.

Abrir Reciente - Abre una de las uUltimas pinturas guardadas.

Guardar... - Guarde su pintura. Si no ha guardado anteriormente, se le pedira que introduzca
el nombre.

Guardar Como... - Guarde una copia de su pintura actual como una nueva en formatos de
reb, .png, .jpg, .bmp vy .tif.

Guardar Iterativo - Guarde versiones numeradas secuencialmente de una imagen. La

primera vez, "_1" se afiade al nombre del archivo. Posteriormente, cada vez el nimero se
incrementa en 1y se crea un nuevo archivo numerados secuencialmente.

Importar... - Importe una imagen en formatos.png, .jpg, .bmp y .tif como la nueva capa.

Publicar... - Publique su pintura en la Galeria de Rebelle. Introduzca el nombre de la pintura,
opcionalmente escriba una descripcidn y etiquetas.
Preferencias de Publicar... - Un sub-menu contiene preferencias de la Galeria.

Preferencias... - Ajuste Preferencias General, Preferencias de Herramientas, de Paleta y del
Teclado. Puede encontrar mas informacidn en la seccion ‘Preferencias’ mas adelante en el
manual.

Quitar - Cierre la aplicacién. (Sélo en Windows).

SUGERENCIA: También puede arrastrar y soltar (Drag & Drop) una imagen desde cualquier
aplicacion, archivo o navegador de Internet directamente a Rebelle si la aplicacion lo
permite.

Para obtener mas informacién sobre cdmo crear, cargar y guardar sus pinturas, consulte la
seccién ‘Crear, Cargar y Guargar Pinturas’ mas adelante en el manual.
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Menu de Editar

Deshacer - Deshace la Ultima operacidn de pintura que ha realizado. NUmero de pasos para
deshacer depende de la memoria de su ordenador. NUmero maximo de estos pasos es 30.
Rehacer - Rehace la ultima operacién de deshacer.

Menu de Capa

Nueva Capa - Agrega una nueva capa.

Duplicar Capa - Duplica capa o capas activas.
Fusionar Capas - Fusione capas en una sola capa.
Eliminar Capa - Elimine capa o capas activas.

Mostrar Capa- Muestre u oculte la capa individual.
® T a 100 Capa de Trazado - Establezca una capa activa como una
capa de trazado de referencia (un pequeno T en vista
previa de Capa aparecerd). Esta capa es una guia para las formas y colores a su pintura -
puede ser una imagen o foto. Puede ajustar la capa de trazado también desde el menu de

panel de capas.

Usar Trazado de Color - Cuando es seleccionado, un color es recogido automaticamente de
la capa de trazado.

Transformar Capa - Mueve y escale la capa activa.
Limpiar Capa - Limpia la capa.

Menu de Vista

Aumentar - Aumente la vista de la pintura (a tamafio maximo de 2000%).

Reducir - Reduzca la vista de la pintura (a un minimo del 5%).

Aumentar al 100% - Comprueba el valor de zoom. Pulse el botdn para restablecer el zoom al
100%.

Encajar en Pantalla - Encaje el lienzo en la pantalla.

Escala de grises - Vea el lienzo en escala de grises.

Mostrar Cursor - Muestre u oculte el cursor.
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Permanecer Arriba - Aplicacién permanecera siempre en la parte superior de otras
aplicaciones.

Pantalla Completa - Cambie la ventana de la aplicacién en modo de pantalla completa.
(Presione Esc para salir).

Menu de Ventana

Herramientas - Muestre u oculte el Panel de Herramientas.
Propiedades - Muestre u oculte el Panel de Propiedades.

Color - Muestre u oculte el Panel de Color.

Conjunto de Color - Muestre u oculte el Panel de Conjunto de Color.
Inclinacidén - Muestre u oculte el Panel de Inclinacién.

Navegador - Muestre u oculte el panel de Navegador.

Capas - Muestre u oculte el Panel de Capas.

Mostrar Paneles - Muestre u oculte los Paneles para conseguir mas espacio para la pintura.
Restablecer a predeterminado - Restablezca la interfaz a interfaz predeterminada.

Menu de Ayuda

Ayuda - Abra este Manual de Usuario.

Enviar Comentarios... - Envienos sus comentarios si usted tiene cualquier problema, una
idea o simplemente le gusta el programa. Puede elegir entre 3 tipos de comentarios:
Bravo - ( Te gustaria expresar como genial Rebelle es? Entonces...
Idea - ¢ Tiene alguna caracteristica que seria una gran adicién a Rebelle? Entonces...
Bug - ¢Encontrd cualquier comportamiento curioso al utilizar Rebelle? Entonces...

... introduzca su correo electrénico y mensaje - leemos cada uno. ©
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Feedback type:

o Brave 3§ ldea % Bug

Email:
email@email.com

Message:

Cancel

Pagina web de Rebelle - Enlace a la pagina web: rebelle.escapemotions.com

Intro Tutorial - Muestra el Intro Tutorial. Este tutorial le guiara a través de las herramientas
mas esenciales en Rebelle.

Acerca de Rebelle - Obtenga un poco de informacién bdsica acerca de Rebelle, copyright y
créditos.

Mostrar Carpeta de Biblioteca ... - Muestra carpeta donde se guardan los pinceles, datos,
documentos y lienzos.

Buscar actualizaciones... - Este botdn es visible cuando hay nuevas actualizaciones
disponibles.
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Preferencias

Ajuste Preferencias General, Preferencias de Herramientas, de Paleta y del Teclado.

- General

- Pantalla de Inicio - Mostrar cuadro de dialégo de "Nueva Pintura" al
inicializacién de la aplicacion - Marque esta opcion si desea que el cuadro de
didlogo “Nueva Pintura” abre cada vez que inicie la aplicacidn.
- Opcidnes de tablet - Seleccione Usar el posicion del ratdn o stylus y
dispositivo Wacom (WinTab) o Microsoft Ink. Reinicié de Rebelle es necesario
para aplicar los cambios.

- Habilitar multi-toque - Desmarque esta opcidn si desea
desactivar soporte multi-tactil en Rebelle.
- Interfaz - Ajuste la escala para cambiar el tamafio de la interfaz (70-200%).
- Lienzo - Aumentar al cursor - Marque esta opcion si desea aumentar al
cursor y no al centro del lienzo.
- Compresion Jpeg - Establezca la calidad del archivo Jpeg.
- Sensibilidad de Box de Editar - Ajuste la sensibilidad de editar del spinbox
para el ratén o tableta grafica (1-100).
- Idioma - Seleccione el idioma de la interfaz. Seleccione si desea actualizar los
idiomas automaticamente.

- Herramientas - Pinceles - Seleccionar el ultimo pincel usado cuando el color es escogido de

- Paleta

la paleta - Marque esta opcidn si desea que el ultimo pincel usado para ser
seleccionado de forma automatica después de escoger un color del Panel de
Color.

- Mostrar capa hiumeda cuando se ulitiza herramienta Mojar o Secar - Marque
esta opcidn si desea que herramientas Mojar y Secar activan el modo Mostrar
Humedo.

- Lazy Mouse - Ajuste la fuerza del Lazy Mouse (0-10). El mayor es numero de
control de Lazy Mouse, las lineas mas suaves se pueden pintar.

- Acelerdmetro - Ajuste la sensibilidad del acelerémetro (1-10).

- Tamano de Muestra de Color de Trazado - Elija el tamafio promedio de la
muestra de trazado de color (1 pixel, 3x3 pixeles, 5x5 pixeles).

- Mezcla de Color - Ajuste la sensibilidad de Mezcla de Color (1-100). La
sensibilidad influye el nUmero de pasos entre dos colores mezclados. Cuando
la sensibilidad es baja, se requieren menos pasos (clics) para alcanzar el
segundo color de la mezcla. Cuando la sensibilidad es alta, se necesita mas
clics para alcanzar el segundo color mezclado.

- Ajustar color con el atajo del teclado (1-10). - Ajuste la sensibilidad de atajos
para ajustar colores.

31



- Teclado - Establezca los atajos de teclado personalizados. Haga clic en Restablecer
para restablecer el atajo actual. Haga clic en Restablecer Todos para
restablecer todos los atajos.

Haga clic en OK para confirmar los cambios realizados en Preferencias o Cancelar, si no lo
desea.
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Empezar a Pintar

Opciones de flujo de trabajo

Empezar una nueva pintura con el lienzo en blanco

1. Haga clic en Archivo -> Nuevo... y una nueva ventana aparecera.

2. Establezca una anchura, una altura de la imagen, la textura del papel y DPI de imagen.
3. Elija el color desde el Panel de Color o Conjunto de Colores.

4. Elija una herramienta, ajuste el tamafo del pincel y otros parametros en el Panel de
Propiedades y empiece a pintar.

Empezar con una foto o una imagen de referencia

1. Haga clic en Archivo -> Abrir... y elija su imagen de referencia.

2. Haga clic en Agregar Capa en Panel de Capas para crear una nueva capa en la parte
superior de la capa de referencia.

3. Elija el color desde el Panel de Color o Conjunto de Colores.

4. Elija una herramienta, ajuste el tamafio del pincel y otros parametros en el Panel de
Propiedades y empiece a pintar.

Puede importar un dibujo previamente escaneada o dibujado en un software tercero en
formato .png, .jpg, .bmp y .tif haciendo clic en Menu -> Archivo -> Importar... (File ->
Import...).

También puede arrastrar y soltar una imagen desde cualquier aplicacidon o navegador de
Internet directamente a Rebelle como una nueva capa.

Trabajar con Agua

Al pintar con un medio humedo (acuarela, acrilico y pluma) se puede establecer la cantidad
de agua. Con mas agua, el color se extendera mas rapido sobre la capa y colores humedos se
mezclan.

No solamente los colores pueden ser himedos, con un botén 'Humedecer Capa' 22 (en
’Panel de Capas’) se puede humedecer la capa completa. Cémo la pintura se mezcla y se seca
depende del agua y la humedad del papel por debajo de ella.

. . Ve ’ . 7 r .
Para ver si o donde una pintura estd humeda, haga clic en el botdn ‘Mostrar Himedo’ @
Un color azul claro muestra la humedad del lienzo y del color - la mayor cantidad de agua se
aplica, el mas oscuro el color azul se mostrara.
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Color Layer/Capa de Show Wet/Mostrar Fast Dry/Secar Rapido  Wet the Dry the
Color Humedo Layer/Humedecer Capa Layer/Secar Capa

Para acelerar su proceso de pintura hemos implementado 2 tunciones:

Botén 'Secar Capa' 3§ seca completamente la capa activa con todo su contenido — la
pintura, el lienzo y agua aplicada.

Puede utilizar un botdn de 'Secar Rapido' flfﬁ cuando quiere agua para ser removido de su
capa activa pero desea mantener la humedad del lienzo.

SUGERENCIA: Pause la simulacion de fluidos en cualquier momento durante la pintura

haciendo clic en el botdn Pausar Difusion en Panel de Capas: E] / @ .

Se pueden utilizar diferentes técnicas de pintura para obtener diversos efectos. En la
siguiente imagen puede ver cdmo diferentes combinaciones interactlan entre si. El mas
himedo el papel y el color, el mas difunde el color. Sin embargo, las herramientas secas
(pastel, lapiz, rotulador y aerégrafo) no se difunden en la pintura menos humeda; se
difunden de acuerdo a humedad de su pintura.

Wet on Wet Paper

"R
-/

Dry on Dry Wet on Dry

Si desea obtener mas informacion sobre la técnica adecuada acuarela, recomendamos ver
nuestros tutoriales en YouTube.
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Opcidn de Trazar una Imagen

Rebelle le permite crear pinturas trazando los colores de una imagen seleccionada. Puede
arrastrar y soltar imagenes directamente desde cualquier aplicacién o navegador de Internet
directamente a Rebelle como una nueva capa. El uso de la opcién de trazar le permite
recrear imagenes existentes en su propia manera.

Cuando se utiliza el trazado de color, el color se aplica para cada trazo. Esto significa que
cada trazo de pincelada recoge el pigmento de color desde el primer "clic" y lo utiliza hasta
qgue hace el otro clic.

Rebelle no traza todos los colores de la capa de trazado durante un solo trazo.

Como trazar una imagen existente o importada:

1. Haga clic en Menu -> Archivo -> Importar... para abrir el cuadro de didlogo de Import.
Una imagen se importa como una nueva capa. También puede arrastrar y soltar
imagenes directamente desde cualquier aplicacidon o navegador de Internet.

2. Seleccione esta capay haga clic en Menu -> Capa -> Capa de Trazado. Una capa se
establece como una capa de trazado de referencia (un pequefio T en la capa de vista
previa aparecerd). Esta capa es una guia para las formas y colores a su pintura.

3. Agregue una nueva capa y haga clic en Menu -> Capa -> Usar Trazado de Color o haga
clicen el botén " Usar Trazado de Color" desde Panel de Conjunto de Colores.

4. Ahora ya esta listo para trazar los colores de su imagen de referencia en una capa
activa.

Si Trazado de Color no es seleccionado usted puede pintar con otros colores. Deseleccione
Capa de Trazado desde Menu -> Capa -> Capa de Trazado.

Capa de Trazado estd bloqueado por defecto para protegerla de cambios no deseados.
Puede desbloquear la capa haciendo clic en el botén de "bloqueo".

Soporte Multitactil

El soporte multitactil estd disponible tanto para Windows y Mac O y ofrece un mayor apoyo
para las tabletas con pantallas tactiles y multitactiles. Puede desplazar, rotar y hacer zoom la
ventana grafica o la capa individual. Esto pofrece una forma sencilla y sensible de
posicionamiento y navegacion por el lienzo.

Use dos dedos para rotar y mover el lienzo al mismo tiempo,
moviéndolos en un movimiento circular mientras lo pasa
simultdneamete a través de la tableta. Al mismo tiempo se puede
zoom la ventana grafica apretando los dedos juntos o separandolos.
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Use un dedo para la herramienta Fusionar de forma predeterminada.
Puede configurarlo para cualquier otra herramienta (o para mover el
lienzo) en el panel de Preferencias -> Teclado -> Herramientas (mantener)
y configurarlo para ‘Toque’.

Lienzos Artisticos

Hay 10 texturas y 15 colores del lienzo predeterminadas para elegir en la ventana
Seleccionar Lienzo:

Paper Texture Paper Color
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Texture visibility:

Paper scale:

Cancel

@ @ - Agrega y elimine la textura del lienzo a / desde ventana de Textura del Lienzo.

@ @ - Agrega y elimine el color del lienzo a / desde ventana de Color del Lienzo.
Se puede controlar la visibilidad de |a textura del papel utilizando el control de Visibilidad de
Textura.

Se puede escalar la textura utilizando el control de control de Escalado de Textura.

Tenga en cuenta que la textura del lienzo afecta la forma en que los pinceles y herramientas
se comportan al pintar, mezclar, borrar o usar cualquier herramienta disponible.

Por ultimo, haga clic en OK para confirmar, o Cancelar, si no lo desea.
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Nota: Texturas del papel son accesibles a través del Menu: Ayuda -> Mostrar Carpeta de
Biblioteca... (Help -> Show Library Folder), donde se puede pegar cualquier textura del lienzo
enlosable a la carpeta del "Papers". Reinicie una aplicacion para recargar nuevos papeles.
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Crear, Cargar y Guargar Pinturas

Crear Nueva Pintura

Para crear una nueva pintura, seleccione la opcidon Nuevo... en el Menu de Archivo. Al hacer
esto, ventana de Nueva Pintura aparecerd. Esta ventana le permite ajustar el tamafio de la
nueva pintura y configurar los ajustes del lienzo. En seccion "Informacién sobre Tamafio de
Imagen” puede comprobar el tamafo de impresion de la imagen tales como anchura, altura
y DPI.

Al hacer clic en el Icono del Lienzo se puede seleccionar el color y la textura del lienzo,
visibilidad y escalado de la textura

Por ultimo, haga clic en OK para crear una nueva pintura, o Cancelar, si no lo desea.

Abrir Pintura

Para abrir una pintura, seleccione la opcién Abrir... en el Menu de Archivo. Este panel le
permite abrir una imagen o ilustracion previamente guardada en el formato de archivo .reb,
.png, .jpg, .bmp y .tif como un nuevo projecto.

Por ultimo, haga clic en OK para abrir la pintura, o Cancelar, si no lo desea.

Para abrir una pintura recientemente guardada, seleccione la opcidn Abrir Reciente en el
Menu de Archivo. Esta opcion le permite seleccionar una de las ultimas pinturas guardadas
en .reb, .png, .jpg, .bomp y .tif formatos de archivo.

Guardar Pintura

Para guardar la pintura, utilice la opcidn Guardar... en el Menu de Archivo. El formato nativo
es formato de archivo REB, que contiene toda la informacién acerca de la pintura y las
capas. Utilice este formato si desea continuar con la pintura mas tarde. Le recomendamos
gue guarde su trabajo periédicamente para evitar cualquier problema, mientras que
acostumbrarse a un nuevo software.

Si desea guardar la pintura con los ajustes especificas o en forma que puede ser leida por
otras aplicaciones, utilice la opcion Guardar Como... del Menu de Archivo. Le permite
guardar la pintura en el formato PNG, TIF, BMP o JPG. No es necesario fusionar capas para
crear una copia de su pintura para la impresion o para mostrar en la web.
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Nota: Por favor, tenga en cuenta que solo el archivo REB contiene toda la informacion de
imagen. Archivos PNG, TIF y BMP guardan solamente la informacion sobre el color y la
transparencia. La transparencia no se guarda en el formato JPG.

Por ultimo, haga clic en OK para guardar la pintura o Cancelar si no lo desea.

Guardar lterativo - Guarde versiones numeradas secuencialmente de una imagen. La

primera vez, "_1" se afiade al nombre del archivo. Posteriormente, cada vez el nimero se

incrementa en 1y se crea un nuevo archivo numerados secuencialmente.

Cerrar Aplicacion

Si desea cerrar una aplicacion, se puede elegir entre las siguientes opciones dependiendo de
su sistema operativo:

Usuario de Windows Usuario de Mac OS
- haga click en Archivo -> Quitar, o - haga click en Archivo -> Quitar, o
- presione un botén Cerrar en la esquina - presione un botén Quitar en la esquina
superior derecha de una aplicacién o superior derecha de una aplicacién o
- utilice el atajo Ctrl+W o Alt+F4 - utilice el atajo Cmd+Q

Nota: Por favor no se olvide de guardar su pintura antes de cerrar una aplicacion.
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Publicar una pintura a Galeria

Crear una Cuenta de Galeria

Para publicar sus pinturas, en primer lugar hay que crear una cuenta. Para crear una cuenta,
tiene dos opciones:

De aplicacion:

Crea tu Cuenta de Galeria desde el Menu de Rebelle: Archivo -> Preferencias de Publicar.
Elija Su Nombre, Correo Electrénico ("Su ID") y la Contrasefia para la galeria y, opcionalmente
el enlace a su Pdgina Web.

De web:

En Pagina web de la Galeria haga click Inicio de sesion -> Crear cuenta (login -> Create
Account) e introduzca "Su ID" (correo electrénico de su registracion).

Le enviaremos una Contrasefia, que se puede cambiar mas adelante.

Nota: Puede encontrar "Su ID" en el menu de Rebelle Ayuda -> Acerca de Rebelle.
Si "Tu ID" no existe, introduzca su direccion de correo electronico activo.

Publicar pinturas de Rebelle a Galleria

Para publicar su pintura, utilice la opcion Publicar... en el Menu de Archivo. Introduzca el
Nombre de la Pintura, un Descripcion y Etiquetas de Pintura. Haga clic en el botdn Publicar.
Tu pintura serd publicada en la pagina web de la Galeria (www.escapemotions.com/gallery),

donde puede editar las imagenes mas tarde.

Editar tu perfil y Pinturas en Galeria

Si ya ha creado una cuenta, vaya al sitio web de Gallery, pulse Login / Iniciar session
eintroduzca"Su ID" y la Contrasefia/Password.

En la seccion Edit Pictures / Editar imagenes se puede editar el nombre de las pinturas,
descripcidn, etiquetas y otros ajustes.

En la seccién My profile / Mi perfil puede cambiar su Contrasefia.
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Atajos de Teclado

New... / Nuevo...

Open... / Abrir...

Save / Guardar

Save As... / Guardar Como...
Iterative Save / Guardar Iterativo
Import.../ Importar...
Preferences / Preferencias

Quit / Quitar

Undo / Deshacer
Redo / Rehacer

Brushes / Pinceles

Eraser / Borrador

Blend / Fusién

Smudge / Manchar

Water /Agua

Dry / Secar

Blow / Soplar

Pick a color / Escoger el Color

Transform Layer / Transformar la Capa

Lock proportions at scale /
Bloquear propociones a escala
Scale around center /

Escalar alrededor del centro
Lock rotation at 45 degrees /
Bloquear rotacién a 45 grados

Mix / Mezclar

Show Wet / Mostrar Himedo
Fast Dry / Secar Rapido
Paint / Pintar

Increase Brush Size /
Aumentar el Tamano del Pincel
Decrease Brush Size /

Windows
Ctrl+N
Ctrl+O
Ctrl+S
Ctrl+Shift+S
Ctrl+Alt+S
Ctrl+Shift+O
Ctrl+,
Ctrl+W

Ctrl+Z
Ctrl+Shift+Z

UEV’ZITIUJ

Shifto O

Alto |

T o Ctrl-T

Shift

Alt

Shift

Mac OS
Cmd+N
Cmd+O
Cmd+S
Cmd+Shift+S
Cmd+Alt+S
Cmd+Shift+O
Cmd+,
Cmd+Q

Cmd+Z
Cmd+Shift+Z

UEV’ZH'IUJ

Shifto O

Alto |

ToCmd-T

Shift

Alt

Shift



Disminuir el Tamano del Pincel [ [
Clear Layer Content /

Move Layers Up /

Mover Capas hacia Arriba Ctrl + [ Cmd + [
Move Layers Down /

Mover Capas hacia Abajo Ctrl +] Cmd +]
Select Prev Layer /

Seleccionar Capa Anterior Alt + Alt + [
Select Next Layer /

Seleccionar Capa Siguente Alt +] Alt +]
Limpiar el Contenido de la Capa Del Del
Increase Value +1 / Aumentar el Valor+1  Up Up
Decrease Value -1 / Disminuir el Valor -1 Down Down
Increase Value +10 / Aumentar el Valor +10 Pg Up Pg Up
Decrease Value -10 / Disminuirel Valor -10 Pg Down Pg Down
Rotate Canvas / Rotar Lienzo R R

Move a Canvas / Mover Lienzo Botdn derecho del ratén o Escpaciador + LMB
Show | Hide All Panels Tab Tab

Zoom In / Aumentar +/Ctrl + + +/Cmd + +
Zoom Out / Reducir -/Ctrl + - -/Cmd + -
Zoom 100% / Acercar 100% 0/Ctrl+0 0/Cmd+0
Fit to Screen / Encajar en Pantalla

Greyscale / Escala de Grises G G

Zoom In | Out / Aumentar | Reducir Desplazamiento o Desplazamiento + Alt
Help / Ayuda F1 F1

Nota: Puede crear ajustes personalisados para esas y otras funciones desde el Menu:
Preferencias -> Teclado (Preferences -> Keyboard).
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Derechos de Autor y Créditos

Rebelle © 2017 Escape Motions, s.r.o.

Escape Motions Equipo:

Peter Blaskovi¢, Michal Fapso, Lubos Toth, Matus Fedorko, Miroslav Sedlak, Anton PoZivenec
Veronika Klimekova, Andrea Vachova

Agradecimientos especiales a:

Todos aquellos, que contribuyeron con ideas, sugerencias, o ayudaron a finalizar Rebelle,
especialmente a Keith Alford, Nigel Brewster, Harvey Bunda, Kris Cooper, Jeanne Corbeil,
Sylvia van Dervis, Rana Dias, Matus Fedorko, Daniel Innes, Vladimir J., Umin Kang, Jim
Kanter, lulia Khestanova, Suawek Kolakowski, John LaBrie, Tomas Lancz, Francis McKeon,
Michelle Parsley, Rastislav Piovarci, Corey Pollack, Elke Schnabel, Kristin Schuricht, Martina
Sesterhenn, Tim Shelbourne, Gina Startup, Martin Surovéek, Mato Tondas, Gregorii Trombo,
Oliver Wetter y Blaze Wu.

Iconos de la Interfaz de Usuario: "Batch" by Adam Whitcroft

Bibliotecas usadas:
Esta aplicacion ha sido desarrollada con las siguientes bibliotecas:

Qt 5.4, LGPL license - http://qt-project.org/downloads/

QuaZIP, LGPL license - http://sourceforge.net/projects/quazip/

CryptoPP, Boost Software license - http://www.cryptopp.com/

ImageMagick, Apache license - http://www.imagemagick.org/

AntiGrain Geometry 2.4, LGPL license - http://agg.sourceforge.net/antigrain.com/index.html
MB WebSockets, LGPL license - https://qt.gitorious.org/gtplayground/mbwebsockets

Gracias a Dios por todas las ideas creativas.
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Rebelle End-User Software License Agreement

Copyright 2015-2017 Escape Motions, s.r.o. All Rights Reserved.

This license is a legal agreement between you and Escape Motions for the use of Rebelle
software (the "Software"). By downloading, installing, copying, or otherwise using the
Software, you acknowledge that you have read terms and conditions of this license,
understand them, and agree to be bound by them. If you do not agree with these terms and
conditions, Escape Motions is unwilling to license the Software to you, and you are not
authorized and may not use the Software.

Permitted Use

Users of the Rebelle may use the Software for commercial, or for-profit activities as well as
for personal, non-commercial, or non-profit activities.

The Software may be installed on a computer that is for multiple users but it may not be
installed on more than one computer regardless of whether those computers are operated
simultaneously or not.

You may install the Software on multiple computers provided that not more than one of
those computers is in use simultaneously and that those computers are solely for your own
personal use.

You may not remove the copyrights notices from the Software. You may make one (1) copy
of the Software for back-up or archival purposes.

Restrictions

This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law
and international treaty. This is a license, not a transfer of title, and unless you have been
granted prior, written consent from Escape Motions you may not:

a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party.

b, Sell, rent, lease, assign, or sublet the Software or portions thereof.

¢, Grant rights to any other person.

d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on
the Software or the documentation in whole or in part.

e, Use the Software in violation of any international law or regulation.

You must not intentionally or unintentionally make the Software available on any web
server, ftp server, file sharing network, shared directory, or other location where any other
person can acquire a copy of the Software. You are responsible for keeping the Software
safe from being copied by others.
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Display of Copyright Notices

All copyright and proprietary notices and logos within the Software files must remain intact.

Indemnity

You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions
or suits, as well as any related expenses, liabilities, damages, settlements or fees arising from
your use or misuse of the Software, or a violation of any terms of this license.

The Software may contain technical inaccuracies or typographical errors, so changes and/or
updates may be affected without notice.

Peter Blaskovic may also make improvements and/or other changes to the Software at any
time without notice.

Disclaimer Of Warranty

THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO,
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR
FITNESS FOR A PARTICULAR PURPOSE. FURTHER, PETER BLASKOVIC DOES NOT WARRANT
THAT THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE.

Limitations Of Liability

YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE
FOR CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION
WITH THE SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING
BUT NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS.
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